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. การ Sign on เขา้สูร่ะบบ 

 
1. Sign on เขา้ระบบ โดยระบ ุUser Name และ Password และคลกิปุ่ ม Log in 

 

 
 

 
2. ระบบแสดง Responsibility ใหเ้ลอืก 
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3. คลกิเลอืก Responsibility ทีต่อ้งการใชง้าน เชน่ SQ1 Receivables Manager 
 

 
 

4. รายการเมนูจะขึน้มาทางดา้นล่าง สว่นดา้นขวาจะเป็นรายการ Worklist 

 

 
 
5. คลกิเลอืกเมนู เพือ่เขา้หนา้จอ  
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6. ระบบจะเขา้สูห่นา้จอ Security Warning  
 

 
 
7. เลอืก  ท ีI accept the risk and want to run this application แลว้กดปุ่ ม Run 

 

 
 

8. ระบบจะเขา้สูห่นา้จอท างาน 
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2. การสรา้งขอ้มูลลกูคา้ (Create Customer) 

เป็นการสรา้งฐานขอ้มูลลกูคา้ในระบบ Oracle เพือ่เป็นขอ้มูลส าหรับการออก Invoice ใหกั้บลกูคา้ได ้เมือ่ตอ้งการสรา้ง
ฐานขอ้มูลลูกคา้ใหม ่ผูใ้ชง้านตอ้งท าการตรวจสอบหาขอ้มูลลกูคา้ในระบบกอ่นเสมอ  

 

การคน้หาขอ้มลูลูกคา้ (หนา้จอ Customization) 

Oracle Menu Path: (N) > Customers > CUP Customer 
 

วตัถปุระสงคแ์ละการท างาน 

 
หนา้จอส าหรับการคน้หาหรอืตรวจสอบขอ้มลู Customer ในระบบ เนื่องจาก Customer R12 ไมส่ามารถคน้หาขอ้มลูโดย

ใช ้%xx%  ได ้เพือ่คน้หาได ้
 

กอ่นการสรา้งขอ้มลู Customer ใหท้ าการตรวจสอบขอ้มลูกอ่น เพือ่ป้องกันการบันทกึขอ้มูลซ ้าในระบบ 
 

1. หนา้จอคน้หา  แสดง Criteria เพือ่คน้หา   

 

 
 
 

ล าดบั ชือ่ฟิลด ์ ค าอธบิาย (*) รายละเอยีดเพิม่เตมิ 

1 Customer 

Number 

แสดง Number, Name 

แสดงขอ้มลูทัง้หมดของ Customer ที่
มใีนระบบ 

  

2 Customer 
Name 

แสดง Name, Number 
แสดงขอ้มลูทัง้หมดของ Customer ที่

มใีนระบบ 

  

3 Status Default Active  
(Active, Inactive, All) 
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2. เลอืกรายการ คลกิ OK 
 

 
 

3. คลกิ Find 

 
 

4. หนา้จอแสดงผลการคน้หา Customers 

 
 

ล าดบั ชือ่ฟิลด ์ ค าอธบิาย (*) รายละเอยีดเพิม่เตมิ 

4 Type แสดง Type : Organization หรอื 

Person 

  

5 Customer 
Name 

แสดง Name, Number 
แสดง Customer Name 
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ล าดบั ชือ่ฟิลด ์ ค าอธบิาย (*) รายละเอยีดเพิม่เตมิ 

6 Account 
Number 

แสดง Customer Number   

7 Status  แสดง Status : Active หรอื Inactive 

ระดับ Customer 

  

8 Tax Register 

Number 

แสดง Tax Register Number เลข

ประจ าตัวผูเ้สยีภาษี 

  

9 Address Address แสดงทีอ่ยู่ 
ถา้ไมม่ขีอ้มูลระดับ Site ของ OU นัน้ๆ 

จะไม่แสดง Adress และ Bill to 
Location 

  

10 Bill To 

Location 

แสดง Bill To Location   
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การสรา้งขอ้มลูลูกคา้ 

 
Oracle Menu Path: (N) > Customers > Customers 

 
วตัถปุระสงคแ์ละการท างาน 

 

เป็นการสรา้งฐานขอ้มูลลกูคา้ในระบบ Oracle เพือ่เป็นขอ้มูลส าหรับการออก Invoice ใหกั้บลกูคา้ได ้เมือ่ตอ้งการสรา้ง
ฐานขอ้มูลลูกคา้ใหม ่ผูใ้ชง้านตอ้งท าการตรวจสอบหาขอ้มูลลกูคา้ในระบบกอ่นเสมอ  

 
1. กอ่นจะสรา้งฐานขอ้มลูลูกคา้ควรท าการคน้หารายชือ่ลูกคา้กอ่น เพือ่ป้องกันการสรา้งฐานขอ้มูลซ ้า  โดยสามารถคน้หา

ไดจ้าก Customer Name หรอื Account Number  และคลกิปุ่ ม Go เพือ่คน้หา 
 

Customer Type: Person 

 

ล าดบั ชือ่ฟิลด ์ ค าอธบิาย (*) รายละเอยีดเพิม่เตมิ 

1 Customer 
Type 

Person: ส าหรับบคุคล 
Organization: ส าหรับนติบิคุคล 

  

2 First Name ระบชุือ่   

3 Last Name ระบนุามสกลุ   

4 Account 

Number 

ระบเุลขทีล่กูคา้   

5 Tax 
Registration 

Number 

ระบเุลขทีบั่ตรประชาชน   

 
 

Customer Type: Organization  
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ล าดบั ชือ่ฟิลด ์ ค าอธบิาย (*) รายละเอยีดเพิม่เตมิ 

6 Customer 
Type 

Person: ส าหรับบคุคล 
Organization: ส าหรับนติบิคุคล 

  

7 Customer ระบชุือ่บรษัิท  *หมายเหต ุการคน้หาหา้มขึน้ตน้

ดว้ย % ควรระบคุ่าเริม่ตน้แลว้
ตามดว้ย % เชน่ บรษัิท สยาม% 

8 Account 

Number 

ระบเุลขทีล่กูคา้   

9 Tax 

Registration 
Number 

ระบเุลขทีบั่ตรประชาชน   

 

2. หากคน้หาแลว้ไมพ่บ และตอ้งการสรา้งขอ้มลูลูกคา้  คลกิปุ่ ม Create เพือ่ท าการเริม่ตน้สรา้งฐานขอ้มูลลูกคา้ 
 

 

ล าดบั ชือ่ฟิลด ์ ค าอธบิาย (*) รายละเอยีดเพิม่เตมิ 

10 Customer 
Type 

Person: ส าหรับบคุคล 
Organization: ส าหรับนติบิคุคล 

*  

 

3. ระบรุายละเอยีดของลกูคา้ ในสว่น Customer Information 

Customer Type: Person 

 

ล าดบั ชือ่ฟิลด ์ ค าอธบิาย (*) รายละเอยีดเพิม่เตมิ 

11 Prefix ค าน าหนา้   

12 First Name ชือ่   

13 Last Name นามสกลุ   
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Customer Type: Organization  
 

 

ล าดบั ชือ่ฟิลด ์ ค าอธบิาย (*) รายละเอยีดเพิม่เตมิ 

14 Organization 

Name 

ระบชุือ่ลกูคา้ * บรษัิท You Are 

 

4. ระบรุะบรุายละเอยีด ในสว่น Account Information 

 

ล าดบั ชือ่ฟิลด ์ ค าอธบิาย (*) รายละเอยีดเพิม่เตมิ 

15 Profile Class เลอืก Profile Class จาก Lov ดังนี้ 
ระบคุา่เป็น DEFAULT  

 

 DEFAULT  
 

16 Account Type เลอืกประเภทลูกคา้จาก List ว่าเป็น 
Internal หรอื External Customer 

ระบบ Default คา่เป็น External 

 

 External 

Flexfield (DFF - Customer Information) 

17 ประเภทบัตร ระบปุระเภทบัตร   

18 ผูอ้อกบัตร ระบผุูอ้อกบัตร   

19 วันทีอ่อกบัตร ระบวัุนทีอ่อกบัตร   

20 วันเกดิ ระบวัุนเกดิ   

21 เชือ้ชาต ิ ระบเุชือ้ชาต ิ   

22 สญัชาต ิ ระบสุัญชาต ิ   

23 เลขทีบั่ญช/ีชือ่
บัญช ี

ระบเุลขทีบั่ญช/ีชือ่บัญช ี   

24 สาเหต ุ

Blacklist 

ระบสุาเหต ุBlacklist   

25 รายละเอยีด 

Blacklist 

ระบรุายละเอยีด Blacklist   

26 Customer 
Long Name 

ระบCุustomer Long Name   
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5. ระบรุายละเอยีดของ Account Site Address และคลกิปุ่ ม Apply  

 
 

ล าดบั ชือ่ฟิลด ์ ค าอธบิาย (*) รายละเอยีดเพิม่เตมิ 

27 Country ระบบจะแสดง Thailand ใหโ้ดย

อัตโนมัต ิ

* Thailand 

28 Address Line1 ระบทุีอ่ยูข่องลูกคา้ที ่address line 1 * 99/99 

29 Address Line2 ระบทุีอ่ยูข่องลูกคา้ที ่address line 2  หมูบ่า้นอยู่สบาย 

30 Address Line3 ระบทุีอ่ยูข่องลูกคา้ที ่address line 3   

31 Province ระบจุังหวัด  กรงุเทพมหานคร 

32 Postal Code ระบรุหัสไปรษณีย ์  10250 

 

6. ระบรุายละเอยีดของ Account Site Details 

 

ล าดบั ชือ่ฟิลด ์ ค าอธบิาย (*) รายละเอยีดเพิม่เตมิ 

33 Operating 
Unit 

แสดง Operating Unit ทีใ่ชง้านอยู่   

Flexfield (DFF - Address Information) 

34 เลขประจ าตัวผู ้
เสยีภาษี 

ระบเุลขประจ าตัวผูเ้สยีภาษี   

35 สาขา ระบสุาขา  00001 

36 Magnet ระบMุagnet   

37 สายป่านยาว ระบสุายป่านยาว   

38 ความร่วมมอืใน

กจิกรรม 

ระบคุวามร่วมมอืในกจิกรรม   

39 ส าหรับสง่ 
Email 

ระบสุ าหรับสง่ Email  Yes 

40 พืน้ทีใ่หเ้ชา่ 

(เลขหอ้ง) 

ระบพุืน้ทีใ่หเ้ชา่ (เลขหอ้ง)   

41 ชือ่กจิการ ระบชุือ่กจิการ   

42 ทีอ่ยูท่ีใ่ชใ้น

ใบเสร็จ

ระบทุีอ่ยู่ทีใ่ชใ้นใบเสร็จ(site_use_id)   
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ล าดบั ชือ่ฟิลด ์ ค าอธบิาย (*) รายละเอยีดเพิม่เตมิ 

(site_use_id) 

43 สงักัด ระบสุงักัด   

44 External 

Reference 

ระบEุxternal Reference   

45 NonVat ทีอ่ยู ่
Customer 

ระบNุonVat ทีอ่ยู ่Customer   

46 หาบเร่ แผง
ลอย (ขาย

อะไร) 

ระบหุาบเร่ แผงลอย (ขายอะไร)   

47 หาบเร่ แผง
ลอย (พืน้ทีใ่ด) 

ระบหุาบเร่ แผงลอย (พืน้ทีใ่ด)   

 

7. ระบรุายละเอยีดของ Business Purpose 

 

* คลกิปุ่ ม  Add Another Row  เพือ่เพิม่บรรทัดใหม ่

 

ล าดบั ชือ่ฟิลด ์ ค าอธบิาย (*) รายละเอยีดเพิม่เตมิ 

47 Business 

Purpose  

เลอืกจาก list of values ระบเุป็น Bill 

To และ Ship To เพือ่ใหส้ามารถตัง้
หนี้ และ รับเงนิตามทีอ่ยูน่ี้ได ้

* Bill To 

48 Location ระบเุป็นชือ่ Location ไดต้ามความ

ตอ้งการ 

* ตามหนังสอืรับรองบรษัิท 

49 Primary ก าหนดใหท้ีอ่ยูน่ี้เป็น Bill To หลักของ

ลกูคา้รายนี้ ถา้มกีารระบวุา่ใหเ้ป็น 

Primary ระบบจะ Default ทีอ่ยูน่ี้
ข ึน้มาให ้เมือ่มกีารออกใบแจง้หนี้  

 √ เลอืก Primary 
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8. เมือ่คลกิปุ่ ม Apply แลว้ระบบจะกลับมาทีห่นา้หลักของการสรา้งฐานขอ้มลูลูกคา้ และระบบจะสรา้ง Account 

Number ใหอั้ตโนมัต ิ

  

 

 
 

9. บันทกึขอ้มูลเลขทีผู่เ้สยีภาษีของลูกคา้ เลอืก Tab Profile และคลกิ Save เพือ่บันทกึ (ระบบจะตรวจสอบกรณี

บันทกึซ ้า) 

 

 
 

ล าดบั ชือ่ฟิลด ์ ค าอธบิาย (*) รายละเอยีดเพิม่เตมิ 

50 Taxpayer ID ระบเุลขประจ าตัวผูเ้สยีภาษี  1122334455668 

51 Tax 
Registration 

Num 

ระบเุลขประจ าตัวผูเ้สยีภาษี  1122334455668 

 

  

Customer Account Number 

Customer Site 
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10. บันทกึขอ้มูลอืน่ๆของลูกคา้ในระดับ Customer Account และคลกิปุ่ ม Detail  
 

 
 

11. การบันทกึขอ้มลู Account Contacts โดยคลกิ Tab Communications และคลกิปุ่ ม Create Contact 

 

 
 

12. ระบขุอ้มูล Contact Information และคลกิ Apply เพือ่บันทกึ 

 

 
 

ล าดบั ชือ่ฟิลด ์ ค าอธบิาย (*) รายละเอยีดเพิม่เตมิ 

52 Prefix ค าน าหนา้  นางสาว 

53 First Name ชือ่  สขุใจ 

54 Last Name นามสกลุ  สบายกาย 
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ล าดบั ชือ่ฟิลด ์ ค าอธบิาย (*) รายละเอยีดเพิม่เตมิ 

55 Phone 
Number 

เบอรโ์ทรศัพท ์
Country Code  

Area Code 
*Number  

  
66 

 
0899999999 

56 Mobile 

Number 

เบอรโ์ทรศัพท ์

Country Code  
Area Code 

*Number  

  

 

57 Country ระบบจะแสดง Thailand ใหโ้ดย
อัตโนมัต ิ

* Thailand 

58 Address Line 

1 

ระบทุีอ่ยูข่องลูกคา้  *  - 

 

13. ระบบแสดงขอ้มลูในสว่นของ Account Contacts  

 
 

14. สามารถคลกิ Details เพือ่ตรวจสอบรายละเอยีดของเบอรโ์ทรศัพท ์หรอื บันทกึขอ้มูล Contact Email เพิม่เตมิได ้

 
 

15. การบันทกึขอ้มลูอืน่ๆของลกูคา้ในระดับ Customer Site ใหเ้ลอืก Tab Sites  และคลกิปุ่ ม Detail ของ Site 
Address นัน้ๆ 
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16. Tab Business Purposes แสดงขอ้มลู Bill To และ Ship To 
 

 
 

17. การบันทกึขอ้มลู Tab Communications  

• Account Site Contacts: ผูต้ดิตอ่, ทีอ่ยู,่ เบอรโ์ทรศัพท ์

• Account Site Phone Numbers: เบอรโ์ทรศัพท ์

• Account Site Email: ขอ้มลู Email 

 

18.      คลกิ Create Contact เพือ่เพิม่ขอ้มลูผูต้ดิต่อ, ทีอ่ยู่, เบอรโ์ทรศัพท ์
 

 
 

19. ระบขุอ้มูล Contact Information และคลกิ Apply เพือ่บันทกึ 

 
 

ล าดบั ชือ่ฟิลด ์ ค าอธบิาย (*) รายละเอยีดเพิม่เตมิ 

59 Prefix ค าน าหนา้  นางสาว 

60 First Name ชือ่  รักด ี

61 Last Name นามสกลุ  ดมีาก 
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ล าดบั ชือ่ฟิลด ์ ค าอธบิาย (*) รายละเอยีดเพิม่เตมิ 

62 Phone 
Number 

เบอรโ์ทรศัพท ์
Country Code  

Area Code 
*Number  

  
66 

 
0899999999 

63 Mobile 

Number 

เบอรโ์ทรศัพท ์

Country Code  
Area Code 

*Number  

  

 

64 Country ระบบจะแสดง Thailand ใหโ้ดย
อัตโนมัต ิ

* Thailand 

65 Address Line 

1 

ระบทุีอ่ยูข่องลูกคา้  *  - 

 

20. ระบบแสดงขอ้มลูในสว่นของ Account Site Contact 

 
 

21. การบันทกึขอ้มลูเบอรโ์ทรศัพท ์Account Site Phone Numbers โดยคลกิเลอืกประเภทในสว่น Create และคลกิ 

Go 

 
 

22. ระบขุอ้มูล และ คลกิ Apply เพือ่บันทกึ 
 

 
 

ล าดบั ชือ่ฟิลด ์ ค าอธบิาย (*) รายละเอยีดเพิม่เตมิ 

66 Country Code ประเทศไทย เลอืก 66  66 

67 Number ระบเุบอรโ์ทรศัพท ์ *  
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23. แสดงขอ้มลูเบอรโ์ทรศัพท ์

 

 
 
 

24. การบันทกึขอ้มลู Email คลกิ Create ในสว่น Account Site Email 

 

 
 

25. ระบขุอ้มูล Email และ คลกิ Apply เพือ่บันทกึ 
 

 
 

ล าดบั ชือ่ฟิลด ์ ค าอธบิาย (*) รายละเอยีดเพิม่เตมิ 

68 Purpose  วัตถปุระสงค ์

• For FI Contact 

• For Invoice 

• For Invoice&Receipt 

• For Invoice_cc 

• For Receipt 

 For Invoice&Receipt 

 

69 Format Text mail with HTML attachment   

70 Email ระบ ุEmail * eemailt50@gmail.com 

 

26. แสดงขอ้มลู Email  
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27. เมือ่บันทกึขอ้มลูครบถว้นแลว้ คลกิ Apply เพือ่บันทกึขอ้มลู Customer 

 

 
 

28. ระบบจะแสดงขอ้ความ Your changes have been saved  ในหนา้จอ Customer ใหค้ลกิปุ่ ม Apply อกีครัง้ 

 

29. ระบบจะแสดงขอ้ความ Your changes have been saved  ในหนา้จอ Customer ใหค้ลกิปุ่ ม Apply อกีครัง้ 
 

 
 

30. ระบบจะแสดงขอ้ความ Your changes have been saved   
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3. การแกไ้ขขอ้มลูลกูคา้ (Edit Customer) 

เป็นการสรา้งฐานขอ้มูลลกูคา้ในระบบ Oracle เพือ่เป็นขอ้มูลส าหรับการออก Invoice ใหกั้บลกูคา้ได ้เมือ่ตอ้งการสรา้ง
ฐานขอ้มูลลูกคา้ใหม ่ผูใ้ชง้านตอ้งท าการตรวจสอบหาขอ้มูลลกูคา้ในระบบกอ่นเสมอ  

 

การเพิม่ขอ้มลูทีอ่ยูใ่หม่ (Address) 

 
Oracle Menu Path: (N) > Customers > Customers 

 

 
วตัถปุระสงคแ์ละการท างาน 

 
เพือ่เพิม่ขอ้มลูทีอ่ยูใ่หม ่(Address)  

 
1. คน้หาชือ่ลกูคา้ในระบบทีต่อ้งการ Inactive โดยสามารถคน้หาไดจ้าก Customer Name หรอื Account Number  

และคลกิปุ่ ม Go เพือ่คน้หา 

 

Customer Type: Person 

 

ล าดบั ชือ่ฟิลด ์ ค าอธบิาย (*) รายละเอยีดเพิม่เตมิ 

1 Customer 
Type 

Person: ส าหรับบคุคล 
Organization: ส าหรับนติบิคุคล 

  

2 First Name ระบชุือ่   

3 Last Name ระบนุามสกลุ   

4 Account 
Number 

ระบเุลขทีล่กูคา้   

5 Tax 

Registration 
Number 

ระบเุลขทีบั่ตรประชาชน   
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Customer Type: Organization  

 

 

ล าดบั ชือ่ฟิลด ์ ค าอธบิาย (*) รายละเอยีดเพิม่เตมิ 

6 Customer 
Type 

Person: ส าหรับบคุคล 
Organization: ส าหรับนติบิคุคล 

  

7 Customer ระบชุือ่บรษัิท  *หมายเหต ุการคน้หาหา้มขึน้ตน้

ดว้ย % ควรระบคุ่าเริม่ตน้แลว้
ตามดว้ย % เชน่ บรษัิท สยาม% 

8 Account 

Number 

ระบเุลขทีล่กูคา้   

9 Tax 

Registration 

Number 

ระบเุลขทีบั่ตรประชาชน   

 

2. ระบบแสดงขอ้ลูกคา้ คลกิทีช่ ือ่ของขอ้มูลลูกคา้ 
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3. ทีร่ะดับ Site คลกิปุ่ ม Create Site 

 

 
 

4. คลกิปุ่ ม Create Address 

 
 

5. ระบรุายละเอยีดของ Account Site Address  
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ล าดบั ชือ่ฟิลด ์ ค าอธบิาย (*) รายละเอยีดเพิม่เตมิ 

1 Country ระบบจะแสดง Thailand ใหโ้ดย
อัตโนมัต ิ

* Thailand 

2 Address Line1 ระบทุีอ่ยูข่องลูกคา้ที ่address line 1 * 88/88 

3 Address Line2 ระบทุีอ่ยูข่องลูกคา้ที ่address line 2  หมูบ่า้นรืน่รม 

4 Address Line3 ระบทุีอ่ยูข่องลูกคา้ที ่address line 3   

5 Province ระบจุังหวัด  กรงุเทพมหานคร 

6 Postal Code ระบรุหัสไปรษณีย ์  10250 

 
6. ระบรุายละเอยีดของ Account Site Details 

 

ล าดบั ชือ่ฟิลด ์ ค าอธบิาย (*) รายละเอยีดเพิม่เตมิ 

7 Operating 

Unit 

แสดง Operating Unit ทีใ่ชง้านอยู่   

Flexfield (DFF - Address Information) 

8 เลขประจ าตัวผู ้

เสยีภาษี 

ระบเุลขประจ าตัวผูเ้สยีภาษี   

9 สาขา ระบสุาขา  00001 

10 Magnet ระบMุagnet   

11 สายป่านยาว ระบสุายป่านยาว   

12 ความร่วมมอืใน

กจิกรรม 

ระบคุวามร่วมมอืในกจิกรรม   

13 ส าหรับสง่ 

Email 

ระบสุ าหรับสง่ Email  Yes 

14 พืน้ทีใ่หเ้ชา่ 
(เลขหอ้ง) 

ระบพุืน้ทีใ่หเ้ชา่ (เลขหอ้ง)   

15 ชือ่กจิการ ระบชุือ่กจิการ   

16 ทีอ่ยูท่ีใ่ชใ้น
ใบเสร็จ

(site_use_id) 

ระบทุีอ่ยู่ทีใ่ชใ้นใบเสร็จ(site_use_id)   

17 สงักัด ระบสุงักัด   

18 External 
Reference 

ระบEุxternal Reference   

19 NonVat ทีอ่ยู ่
Customer 

ระบNุonVat ทีอ่ยู ่Customer   

20 หาบเร่ แผง

ลอย (ขาย
อะไร) 

ระบหุาบเร่ แผงลอย (ขายอะไร)   

21 หาบเร่ แผง

ลอย (พืน้ทีใ่ด) 

ระบหุาบเร่ แผงลอย (พืน้ทีใ่ด)   
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7. ระบรุายละเอยีดของ Business Purpose 

 

* คลกิปุ่ ม  Add Another Row  เพือ่เพิม่บรรทัดใหม ่

 

ล าดบั ชือ่ฟิลด ์ ค าอธบิาย (*) รายละเอยีดเพิม่เตมิ 

22 Business 

Purpose  

เลอืกจาก list of values ระบเุป็น Bill 

To และ Ship To เพือ่ใหส้ามารถตัง้

หนี้ และ รับเงนิตามทีอ่ยูน่ี้ได ้

* Bill To 

23 Location ระบเุป็นชือ่ Location ไดต้ามความ

ตอ้งการ 

* ตามหนังสอืรับรองบรษัิท 

24 Primary ก าหนดใหท้ีอ่ยูน่ี้เป็น Bill To หลักของ
ลกูคา้รายนี้ ถา้มกีารระบวุา่ใหเ้ป็น 

Primary ระบบจะ Default ทีอ่ยูน่ี้
ข ึน้มาให ้เมือ่มกีารออกใบแจง้หนี้  

 √ เลอืก Primary 

 

 
8. คลกิปุ่ ม Finish จะกลับมาหนา้ Site Information จากนัน้สามารถบันทกึขอ้มูลอืน่ๆ ไดแ้ละ คลกิ Apply เพือ่บันทกึ

ขอ้มลู 
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การแกไ้ขขอ้มลู Email 

 
Oracle Menu Path: (N) > Customers > Customers 

 
วตัถปุระสงคแ์ละการท างาน 

 

การแกไ้ขขอ้มลู Email 
 

1. คน้หาชือ่ลกูคา้ในระบบทีต่อ้งการ Inactive โดยสามารถคน้หาไดจ้าก Customer Name หรอื Account Number  
และคลกิปุ่ ม Go เพือ่คน้หา 

 

Customer Type: Person 

 

ล าดบั ชือ่ฟิลด ์ ค าอธบิาย (*) รายละเอยีดเพิม่เตมิ 

1 Customer 

Type 

Person: ส าหรับบคุคล 

Organization: ส าหรับนติบิคุคล 

  

2 First Name ระบชุือ่   

3 Last Name ระบนุามสกลุ   

4 Account 
Number 

ระบเุลขทีล่กูคา้   

5 Tax 

Registration 
Number 

ระบเุลขทีบั่ตรประชาชน   

 

 
Customer Type: Organization  
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ล าดบั ชือ่ฟิลด ์ ค าอธบิาย (*) รายละเอยีดเพิม่เตมิ 

6 Customer 
Type 

Person: ส าหรับบคุคล 
Organization: ส าหรับนติบิคุคล 

  

7 Customer ระบชุือ่บรษัิท  *หมายเหต ุการคน้หาหา้มขึน้ตน้

ดว้ย % ควรระบคุ่าเริม่ตน้แลว้
ตามดว้ย % เชน่ บรษัิท สยาม% 

8 Account 

Number 

ระบเุลขทีล่กูคา้   

9 Tax 

Registration 
Number 

ระบเุลขทีบั่ตรประชาชน   

 

2. ระบบแสดงขอ้ลูกคา้ คลกิทีช่ ือ่ของขอ้มูลลูกคา้ 
 

 
 

3. ทีร่ะดับ Site คลกิ Details 
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4. คลกิ Tab Communication เพือ่เพิม่/แกไ้ข Email Address 
 

 
 

5. ในสว่น Account Site Email 

• กรณีเพิม่ Email ใหม ่ ใหค้ลกิ Create 

• กรณีตอ้งการแกไ้ข ใหเ้ลอืก Update ของ Email ทีต่อ้งการแกไ้ข 

 
 

6. เมือ่เพิม่/แกไ้ข เรยีบรอ้ยแลว้  คลกิ Apply เพือ่บันทกึขอ้มลู 
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4. การ Inactive ขอ้มูลลกูคา้ 

 
วตัถปุระสงคแ์ละการท างาน 

 

เป็น Inactive Customer ทีไ่ม่ใชง้าน  

 

Inactive Customer Site ทีไ่มใ่ชง้าน 

 

Oracle Menu Path: (N) > Customers > Customers 
 

 
วตัถปุระสงคแ์ละการท างาน 

 

เป็น Inactive Customer Site ทีไ่มใ่ชง้าน  
 

 
1. คน้หาชือ่ลกูคา้ในระบบทีต่อ้งการ Inactive โดยสามารถคน้หาไดจ้าก Customer Name หรอื Account Number  

และคลกิปุ่ ม Go เพือ่คน้หา 

 

Customer Type: Person 

 

ล าดบั ชือ่ฟิลด ์ ค าอธบิาย (*) รายละเอยีดเพิม่เตมิ 

1 Customer 
Type 

Person: ส าหรับบคุคล 
Organization: ส าหรับนติบิคุคล 

  

2 First Name ระบชุือ่   

3 Last Name ระบนุามสกลุ   

4 Account 
Number 

ระบเุลขทีล่กูคา้   

5 Tax 
Registration 

Number 

ระบเุลขทีบั่ตรประชาชน   
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Customer Type: Organization  

 

ล าดบั ชือ่ฟิลด ์ ค าอธบิาย (*) รายละเอยีดเพิม่เตมิ 

6 Customer 

Type 

Person: ส าหรับบคุคล 

Organization: ส าหรับนติบิคุคล 

  

7 Customer ระบชุือ่บรษัิท  *หมายเหต ุการคน้หาหา้มขึน้ตน้
ดว้ย % ควรระบคุ่าเริม่ตน้แลว้

ตามดว้ย % เชน่ บรษัิท สยาม% 

8 Account 
Number 

ระบเุลขทีล่กูคา้   

9 Tax 
Registration 

Number 

ระบเุลขทีบั่ตรประชาชน   

 
2. ระบบแสดงขอ้ลูกคา้ คลกิทีช่ ือ่ของขอ้มูลลูกคา้ 

 

 
 

3. ทีร่ะดับ Site คลกิ Details 
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4. ในสว่นของ Account Site Address ทีฟิ่ลด ์Status เปลีย่น  Active เป็น Inactive และกด Apply 

 
 

5. คลกิ Apply เพือ่บันทกึ  

 

 
 

 

6. คลกิ Apply เพือ่บันทกึ ไปจนถงึหนา้คน้หา Customer 
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Inactive Customer ทีไ่มใ่ชง้าน 

 
Oracle Menu Path: (N) > Customers > Customers 

 

วตัถปุระสงคแ์ละการท างาน 
 

เป็น Inactive Customer ทีไ่ม่ใชง้าน  
 

1. คน้หาชือ่ลกูคา้ในระบบทีต่อ้งการ Inactive โดยสามารถคน้หาไดจ้าก Customer Name หรอื Account Number  
และคลกิปุ่ ม Go เพือ่คน้หา 

 

Customer Type: Person 

 

ล าดบั ชือ่ฟิลด ์ ค าอธบิาย (*) รายละเอยีดเพิม่เตมิ 

1 Customer 

Type 

Person: ส าหรับบคุคล 

Organization: ส าหรับนติบิคุคล 

  

2 First Name ระบชุือ่   

3 Last Name ระบนุามสกลุ   

4 Account 

Number 

ระบเุลขทีล่กูคา้   

5 Tax 

Registration 

Number 

ระบเุลขทีบั่ตรประชาชน   

 

Customer Type: Organization  
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ล าดบั ชือ่ฟิลด ์ ค าอธบิาย (*) รายละเอยีดเพิม่เตมิ 

6 Customer 
Type 

Person: ส าหรับบคุคล 
Organization: ส าหรับนติบิคุคล 

  

7 Customer ระบชุือ่บรษัิท  *หมายเหต ุการคน้หาหา้มขึน้ตน้

ดว้ย % ควรระบคุ่าเริม่ตน้แลว้
ตามดว้ย % เชน่ บรษัิท สยาม% 

8 Account 

Number 

ระบเุลขทีล่กูคา้   

9 Tax 

Registration 
Number 

ระบเุลขทีบั่ตรประชาชน   

 

2. ระบบแสดงขอ้ลูกคา้ คลกิทีช่ ือ่ของขอ้มูลลูกคา้ 
 

 
 

3. ทีร่ะดับ Account คลกิ Details 
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4. ในสว่นของ Account Site Address ทีฟิ่ลด ์Status เปลีย่น  Active เป็น Inactive และกด Apply 
 

 
 

5. คลกิ Apply เพือ่บันทกึ  

 

 
 

6. คลกิ Apply เพือ่บันทกึ ไปจนถงึหนา้คน้หา Customer 
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5. การสรา้งขอ้มูลลกูคา้จากหนว่ยงานทีม่อียูแ่ลว้ 

 
Oracle Menu Path: (N) > Customers > Customers 

 

วตัถปุระสงคแ์ละการท างาน 
 

เป็นการสรา้งฐานขอ้มูลลกูคา้ในระบบ กรณีม ีCustomer รายเดยีวกันกับ BU อืน่ๆ เชน่ SQ1 มลีกูคา้ชือ่ บรษัิท You Are 
และตอ้งการใหเ้ป็นลกูคา้ใน HOP ดว้ย 
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1. ขอ้มูลลูกคา้ใน BU SQ1 

 

2. เขา้หนา้ Customer ของ BU ทีต่อ้งการ เชน่ HOP และคน้หาขอ้มลู Customer ทีต่อ้งการ 

โดยสามารถคน้หาไดจ้าก Customer Name หรอื Account Number  และคลกิปุ่ ม Go เพือ่คน้หา 

*หมายเหต ุการคน้หาหา้มขึน้ตน้ดว้ย % ควรระบคุ่าเริม่ตน้แลว้ตามดว้ย % เชน่ บรษัิท% 

 

3. ระบบแสดงขอ้ลูกคา้ คลกิทีช่ ือ่ของขอ้มูลลูกคา้ 
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4. ในสว่นของขอ้มูลระดับ Customer Site คลกิปุ่ ม Create Site 

 

5. ระบบแสดงขอ้มลู Site Address หากตอ้งการ ใช ้Site Address ดังกลา่ว ใหก้ดปุ่ ม Continue  
หากตอ้งการสรา้งใหมใ่ห ้คลกิ Create Address เพือ่สรา้งทีอ่ยูใ่หม่ 

 

6. หลังจากคลกิ Continue ระบบจะ Copy ในสว่นของทีอ่ยูม่าให ้ 
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7. ระบขุอ้มูลอืน่ๆ ในสว่นของ Customer Site และ Business Purpose, Tab Communication หลังจากระบขุอ้มูล
ครบถว้น คลกิ Finish 

 

 

 
 

8. ตรวจสอบหรอืระบขุอ้มลูอืน่ๆ Tab Communication หลังจากระบขุอ้มูลครบถว้น คลกิ Apply 
 

 

9. คลกิปุ่ ม Apply เพือ่บันทกึ 
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10. คลกิปุ่ ม Apply ไปจนถงึหนา้คน้หา Customer 
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6. การสง่รายการบญัช ีไปยงัระบบบญัชแียกประเภทท ัว่ไป 

 
วตัถปุระสงคแ์ละการท างาน 

 

เพือ่ท าการสง่รายการบัญชทีีถู่กสรา้งขึน้ไปยังระบบบัญชแียกประเภทท่ัวไป โดยระบบบัญชลีกูหนี้  

สามารถท าการสรา้งรายการบัญชไีด ้2 วธิ ี

1. สรา้งรายการบัญชทีีห่นา้จอการตัง้หนี้ และ หนา้จอการรับช าระ 

2. สรา้งรายการบัญชโีดยโปรแกรม Create Accounting 

 

สรา้งรายการบญัชหีนา้จอต ัง้หนี ้

       

Oracle Menu Path: (N) Transactions > Transaction Summary  
  

สรา้งรายการบัญชหีนา้จอตัง้หนี้ 
 

1. เขา้หนา้จอ Transactions Summary         

ระบ ุTransaction Numbers ทีต่อ้งการสรา้งรายการบัญช ีและกดปุ่ ม  เพือ่คน้หา 
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2. ระบบแสดงรายการทีต่อ้งตามเงือ่นไขการคน้หา และคลกิปุ่ ม  
 

 
 

3. ไปทีเ่มนู (M) Tools > Create Accounting 
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4. เลอืก Option การสรา้งรายการบัญช ี

• Create Final Account Post to GL : สรา้งรายการบัญชแีละสง่ไประบบ GL 

• Create Final Account: สรา้งรายการบัญชแีตยั่งไม่สง่ไป GL (ไมส่ามารถกลับมาแกไ้ขรายการได)้ 

• Create Draft Account: สรา้งรายการบัญชแีบบร่าง (สามารถกลับมาแกไ้ขรายการได)้ 
 

 
 

5. ระบบแสดงขอ้ความเมือ่สรา้งรายการบัญชสี าเร็จ คลกิปุ่ ม  
  

 

 
6. เมือ่สรา้งรายการบัญชเีรยีบรอ้ยแลว้ สามารถดรูายการบัญชทีีเ่กดิขึน้ โดยไปที ่(M) Tools > View Accounting 
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7. ระบบแสดงรายการบัญช ี
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สรา้งรายการบญัชหีนา้รบัช าระเงนิ 

 
Oracle Menu Path: (N) Receipts > Batches Summary  

  
สรา้งรายการบัญชหีนา้รับช าระเงนิ 

 

1. เขา้หนา้จอ Batches Summary 

ระบ ุReceipt Numbers ทีต่อ้งการสรา้งรายการบัญช ีและคลกิปุ่ ม  เพือ่คน้หา 

 

 
 

2. ระบบแสดงรายการทีต่อ้งตามเงือ่นไขการคน้หา และคลกิปุ่ ม  
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3. คลกิปุ่ ม Receipts   

 

 
 

4. คลกิ Open 
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5. ไปที ่เมนู (M) Tools > Create Accounting 
 

 
 

6. เลอืก Option การสรา้งรายการบัญช ี

• Create Final Account Post to GL : สรา้งรายการบัญชแีละสง่ไประบบ GL 

• Create Final Account: สรา้งรายการบัญชแีตยั่งไม่สง่ไป GL (ไมส่ามารถกลับมาแกไ้ขรายการได)้ 

• Create Draft Account: สรา้งรายการบัญชแีบบร่าง (สามารถกลับมาแกไ้ขรายการได)้ 
 

 
 

7. ระบบแสดงขอ้ความเมือ่สรา้งรายการบัญชสี าเร็จ คลกิปุ่ ม  
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8. เมือ่สรา้งรายการบัญชเีรยีบรอ้ยแลว้ สามารถดรูายการบัญชทีีเ่กดิขึน้ โดยไปที ่(M) Tools > View Accounting 

 

 
 

9. ระบบแสดงรายการบัญช ี
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สรา้งรายการบญัช ีโดยการ Run Program 

          
Oracle Menu Path: (N) > View > Request 

 

1. เขา้สูห่นา้จอ Submit a New Request เพือ่ออกรายงานใหม่ และ คลกิปุ่ ม  

 

 

 

2. Name: ระบุชือ่รายงาน “Create Accounting” ระบบจะแสดงหนา้จอ Parameters ใหร้ะบเุงือ่นไขในการสัง่ Run 

ในขัน้ตอนต่อไป คลกิปุ่ ม   เพือ่ออกจากหนา้จอ Parameters นี้ เพือ่กลับไปยังหนา้จอ Submit Request 
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ล าดบั ชือ่ฟิลด ์ ค าอธบิาย (*) รายละเอยีดเพิม่เตมิ 

1 Ledger ชือ่ Ledger * สว่นบรหิารกจิการสยามสแควรวั์น 

2 Process 

Category 

เลอืกชนดิของรายการทีต่อ้งการใหส้รา้ง

รายการบัญช ี
 

* ไมต่อ้งระบ ุเพือ่ใหร้ะบบดงึขอ้มลู

มาทุกชนดิใน AR Module ทัง้ที่
เป็น Transactions, 

Adjustments, Standard 
Receipts และ Misc Receipts 

3 End Date ระบวัุนทีส่ ิน้สดุ ทีต่อ้งการใหร้ะบบเรยีก

ขอ้มลูมาท าการสง่ไปยัง GL 

* ระบุวันทีปั่จจุบัน เชน่ 20-JUL-

2024 

4 Mode ใหก้ารสรา้งรายการบัญชเีป็นแบบ Draft 

หรอื Final 

 
Final: xxสรา้งรายการบัญชแีต่ยังไม่

สง่ไป GL (ไม่สามารถกลับมาแกไ้ข
รายการได)้ 

Draft: สรา้งรายการบัญชแีบบร่าง 

* Final 

5 Errors Only ระบ ุใหร้ายงานโชวร์ายการที ่Error 
อยา่งเดยีวหรอืไม ่(เลอืก = No) 

* No 

6 Report ระบ ุใหม้รีายงานโชวข์ึน้มาหรอืไม ่และ

ถา้ใหโ้ชวร์ายงาน จะใหโ้ชวเ์ป็นแบบ 
Detail หรอื Summary (เลอืก = Detail, 

Summary) 

* Detail 

7 Transfer to 
General 

Ledger 

ระบ ุใหร้ะบบท าการสง่รายการไปยัง GL
หรอืไม ่(เลอืก = Yes) 

* Yes 

8 Post in 
General 

Ledger 

ระบ ุใหร้ะบบท าการ Post รายการที ่GL 
เลยหรอืไม ่หลังจากทีม่กีารสง่ขอ้มลูไป

ยัง GL แลว้ 

•  

* Yes 

9 General 

Ledger Batch 

Name 

ระบชุือ่ Bath รายการบัญชทีีส่ง่ไป GL 

(ระบ ุหรอื ไมร่ะบุก็ได)้ 

  

10 Include User 

Transaction 

Identifiers 

เลอืกวา่แสดงขอ้มลูเพิม่เตมิหรอืไม่ 

• No 

• Yes 

* Yes 
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3. กดปุ่ ม   เพือ่สัง่ Run รายงาน 

 
 

4. เขา้ทีเ่มนู View > Requests  กดปุ่ ม  เมือ่เขา้สูห่นา้จอ Requests กดปุ่ ม Refresh หรอื Auto 

Refresh เพือ่ใหร้ะบบแสดงสถานะล่าสดุ จากตัวอย่าง จะเห็น Request ม ีPhase เป็น Completed และ Status 
เป็น Normal แลว้  

รายการ Request ม ี5 รายการ 

• Create Accounting 

• Accounting Program 

• Journal Import 

• Posting: Single Ledger 

• Update Subledger Accounting Balances 
 

 
 

5. เมือ่กดปุ่ ม   รายการ Create Accounting 
สว่นของ Report Summary จะแสดงรายการที ่Process กับรายการที ่Error 
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6. โดยรายงานแสดงรายการบัญชทีีบั่นทกึ ดังนี้ 
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7. Journal ทีส่ง่ไปที ่GL 

• Journal Source = Receivables 
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7. การจดัพมิพร์ายงาน 

 
Oracle Menu Path: Menu > View > Request 

 

วตัถปุระสงคแ์ละการท างาน 
 

เป็นหนา้จอทีใ่ชใ้นการพมิพร์ายงานหรอืตรวจดโูปรแกรมที ่Run ได ้หนา้จอนี้สามารถ  
 

1. Find: เพือ่คน้หาหรอืตรวจสอบรายการทีป่ระมวลผล 
2. Submit a New Request: กรณีจัดพมิพร์ายงานเดยีว 

3. Submit New Request Set:  กรณีจัดพมิพเ์ป็นชดุรายงาน 1 ชดุรายงาน (จะมหีลายโปรแกรมหรอืหลาย

รายงานอยูใ่น 1 ชดุ) 

 

การคน้หารายงานหรอืการตรวจสอบรายการทีป่ระมวลผล 

 

Oracle Menu Path: Menu > View > Request 
 

วตัถปุระสงคแ์ละการท างาน 

 
เป็นหนา้จอทีใ่ชใ้นการพมิพร์ายงานหรอืตรวจสอบโปรแกรมที ่Run ได ้โดยตอ้งเลอืก Tab “View” และเลอืกทีเ่มนู 

“Requests” จากนัน้กดปุ่ ม (B) Find โดยขัน้ตอนการท างาน มดีังนี้ 
 

 
1. เขา้สูห่นา้จอ Submit a New Request เพือ่ตรวจสอบรายงานทีป่ระมวลผล เลอืกเมนู “View” และเลอืกทีเ่มนู 

“Requests”  
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2. เมือ่เขา้มา ระบบจะแสดงหนา้จอ Find Requests 

 

 
 

3. ระบ ุParameter ในการคน้หารายงาน ตามรายละเอยีดดังนี้ แลว้กดปุ่ ม Find 

 

ล าดบั ชือ่ฟิลด ์ ค าอธบิาย (*) รายละเอยีดเพิม่เตมิ 

1 My Completed 

Requests 

คน้หารายการทีป่ระมวลผลเสร็จแลว้   

2 My Requests 
In Progress 

คน้หารายการทีอ่ยูร่ะหวา่งการ
ประมวลผล 

  

3 All My 

Requests 

คน้หาทุกรายการ   

4 Specific 

Requests 

คน้หารายการโดยระบเุงือ่นไข 

Request ID:  เลขทีก่ารประมวลผล 

Name:         ชือ่การประมวลผล 
Date Submitted:  วันทีส่ัง่ประมวลผล 

Date Completed: วันทีป่ระมวลผล 
                         เสร็จ 

Status:         สถานะของรายการ 

Phase:         ขัน้ตอนการประมวลผล 
Requestor:   ผูส้ัง่ประมวลผล 

  

5 Select the 
number of 

Days to view 

จ านวนวันยอ้นหลังทีต่อ้งการคน้หา   
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4. เมือ่กดปุ่ ม Find ระบบจะแสดงรายงานตามเงือ่นไขทีเ่ลอืก 

 

 
 

5. ตรวจสอบรายงานหรอืโปรแกรม (Name) ทีต่อ้งการ วา่ Phase และ Status เป็นอยา่งไร 
6. เลอืกรายงาน (Name) ทีต่อ้งการ แลว้กดปุ่ ม View Output เพือ่แสดงผลของรายงานบนหนา้จอ 
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ล าดบั ชือ่ฟิลด ์ ค าอธบิาย (*) รายละเอยีดเพิม่เตมิ 

1 Refresh Data กรณีทีม่กีาร Run รายงานการ

ประมวลผลยังไม ่Completed ตอ้งการ 
Manual กดปุ่ ม Refresh Data เพือ่ดู

การเปลีย่นแปลงของการประมวผล 

จนกระท่ังเป็น Completed ซึง่ที ่
Phase เป็น  

Inactive:  ระบบไม่ท างาน ตอ้งแจง้
ผูด้แูลระบบ 

Pending:  รอการประมวลผล 

Running: ก าลังประมวลผล 
Completed:  ประมวลผลเสร็จสิน้ 

 กดปุ่ มเอง 

2 Auto Refresh กรณีทีม่กีาร Run รายงานการ
ประมวลผลยังไม ่Completed ตอ้งการ 

Auto refresh ใหอั้ตโนมัต ิโดยการ

คลิ๊ก √ ทีก่ลอ่งสีเ่หลีย่ม Auto 
Refresh เพือ่ใหร้ะบบท างานอัตโนมัต ิ

ดกูารเปลีย่นแปลงของการประมวผล  

 √ ทีก่ล่องสีเ่หลีย่ม Auto 
Refresh  

3 Submit a New 
Request 

ตอ้งการจัดพมิพร์ายงานเดยีวใหม ่  เมือ่กดเขา้มา ระบบใหเ้ลอืกชือ่
รายงานเดยีวทีต่อ้งการจัดพมิพ์ 

4 Submit a New 
Request Set 

ตอ้งการจัดพมิพร์ายงานชดุใหม ่  เมือ่กดเขา้มา ระบบใหเ้ลอืกชือ่
รายงานชดุทีต่อ้งการจัดพมิพ์ 

5 Copy Single 

Request 

ตอ้งการจัดพมิพร์ายงานเดยีวใหมโ่ดย

วธิ ีCopy 

 เมือ่กดเขา้มา ระบบให ้Find หา

รายงานเดยีวทีเ่คยจัดพมิพเ์ลอืก 
เพือ่จัดพมิพใ์หม ่

6 Copy Request 

Set 

ตอ้งการจัดพมิพร์ายงานชดุใหมโ่ดยวธิ ี

Copy 

 เมือ่กดเขา้มา ระบบให ้Find หา

รายงานชดุทีเ่คยจัดพมิพเ์ลอืก 
เพือ่จัดพมิพใ์หม ่

7 Rerun 

Request 

ตอ้งการรันรายงานเดมิอกีครัง้ ดว้ย

พารามเิตอรเ์ดมิ 

  

8 Phase ขัน้ตอนการประมวลผล 

Inactive:  ระบบไม่ท างาน ตอ้งแจง้ 

              ผูด้แูลระบบ 
Pending:  รอการประมวลผล 

Running:  ก าลังประมวลผล 
Completed:  ประมวลผลเสร็จสิน้ 

 ถา้ส าเร็จเป็น Completed 

9 Status สถานะของรายการ 

Cancelled: ถกูยกเลกิ 
Disabled:  ไมม่สีทิธิ ์

Error:       มขีอ้ผดิพลาด 
No Manager: ระบบไม่ท างาน 

On Hold:       Hold 

Scheduled:    ตัง้เวลาไว ้
Standby:       รอ 

Terminated:  สิน้สดุ 
Terminating: ก าลังท าการสิน้สดุ 

Waiting:       รอ 
Warning:      เตอืน  
Normal:       ปกต ิ

 ถา้ส าเร็จเป็น Normal 

 
 

 

 
 

 
 



                                                                                                                                                                                                             

   File Ref:  PMCU-AR-R12 Training Manual Draft 1.0.doc 
    

      57 of 68 

 

การจดัพมิพร์ายงานเดยีว (Submit a New Request) 

 
Oracle Menu Path: Menu > View > Request 

 
วตัถปุระสงคแ์ละการท างาน 

 

เป็นหนา้จอทีใ่ชใ้นการพมิพร์ายงานกรณีจัดพมิพร์ายงานเดยีว โดยเลอืก Tab “View” และเลอืกทีเ่มนู “Requests”  
 

 
1. เขา้สูห่นา้จอ Submit a New Request เพือ่ออกรายงานใหม่ เลอืกเมนู “View” และเลอืกทีเ่มนู “Requests”  

 

 
 

2. จากนัน้กดปุ่ ม (B) Submit a New Request…   
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3. เขา้สูห่นา้จอ Submit Request เพือ่ระบชุือ่รายงานทีต่อ้งการ และเงือ่นไขของรายงาน  
 

 
 
 
 
 
 
 



                                                                                                                                                                                                             

   File Ref:  PMCU-AR-R12 Training Manual Draft 1.0.doc 
    

      59 of 68 

4. Name: ระบุชือ่รายงาน ทีต่อ้งการสัง่ Run หรอืกดปุ่ ม   เพือ่ใหร้ะบบแสดงชือ่รายงานใหเ้ลอืก 

ตัวอยา่งเชน่ รายงาน Transaction Register 

 

 
 
 

5. ระบบจะแสดงหนา้จอ Parameters ใหร้ะบเุงือ่นไข ซึง่เป็นเงือ่นไขในการดงึขอ้มูลออกในรายงาน แลว้กด OK 
หลังจากนัน้ใหก้ดปุ่ ม Submit 
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6. ระบบแสดงหมายเลข Request ID ของรายงานและแสดงขอ้ความ Submit another request? เพือ่สอบถามวา่
ตอ้งการรันรายงานอืน่ต่ออกีหรอืไม่ 

Yes: ตอ้งการเลอืกรายงานใหมท่ีต่อ้งการอกี 

No: ไมต่อ้งการ 
 

 
 

7. ระบบจะแสดงหนา้จอ Find Request ใหก้ดปุ่ ม Find 
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8. กดปุ่ ม Refresh Data เพือ่ดคูา่ Phase และ Status ของรายงานทีส่ัง่ Run ซึง่จะเปลีย่นแปลงไปจนกระท่ัง Phase 

มคีา่เป็น “Completed” และ Status มคีา่เป็น “Normal” จงึถอืวา่การสัง่ Run Report ในครัง้นี้ท างานเสร็จสิน้
สมบรูณ์ พรอ้มใหผู้ใ้ชดู้ผลลัพธต์อ่ไป 

 

 
 

9. ระบบจะแสดงเลขที ่Request ID ทัง้หมด ใหค้น้หารายงานทีร่ันโดย ด ูRequest ID ทีต่อ้งการหรอื Name = 
รายงานทีร่ัน จากตัวอย่างคอืรายงาน  Transaction Register เมือ่สถานะเป็น Completed/Normal แลว้จงึกดปุ่ ม 

View output 
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10. ระบบแสดงรายงานบนหนา้จอ 
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การจดัพมิพร์ายงานเป็นชุด  (Submit New Request Set) 

 
Oracle Menu Path: Menu > View > Request 

 

วตัถปุระสงคแ์ละการท างาน 
 

เป็นหนา้จอทีใ่ชใ้นการพมิพร์ายงานกรณีจัดพมิพเ์ป็นชดุรายงาน 1 ชดุรายงานจะมหีลายโปรแกรมหรอืหลายรายงาน 
อยูใ่น 1 ชดุ โดยตอ้งเลอืก Tab “View” และเลอืกทีเ่มนู “Requests”  

 
1. เขา้สูห่นา้จอ Submit New Request Set เพือ่ออกรายงานใหม่ เลอืกเมนู “View” และเลอืกทีเ่มนู “Requests” 

 

 
 

1. จากนัน้กดปุ่ ม (B) Submit a New Request…   
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2. เขา้สูห่นา้จอ Submit Request เพือ่ระบชุือ่รายงานทีต่อ้งการ และเงือ่นไขของรายงาน  
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3. Request Set: ระบุชือ่ชดุรายงาน ทีต่อ้งการสัง่ Run หรอืกดปุ่ ม  เพือ่ใหร้ะบบแสดงชือ่รายงานใหเ้ลอืก 

ตัวอยา่งเชน่ SQ1-ปิดระหว่างวัน(New) 

 

 
 
 

4. ระบบจะแสดงหนา้จอ Parameters ใหร้ะบเุงือ่นไขของแตล่ะรายงาน ซึง่เป็นเงือ่นไขในการดงึขอ้มลูออกในรายงาน 
แลว้กด OK  
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5. เมือ่ระบ ุParameter เรยีบรอ้ยแลว้ กดปุ่ ม Submit 
 

 
 

6. ระบบแสดงหมายเลข Request ID ของรายงานและแสดงขอ้ความ Submit another request? เพือ่สอบถามวา่
ตอ้งการรันรายงานอืน่ต่ออกีหรอืไม่ 

Yes: ตอ้งการเลอืกรายงานใหมท่ีต่อ้งการอกี 
No: ไมต่อ้งการ 

 

 
 

7. ระบบจะแสดงหนา้จอ Find Request ใหก้ดปุ่ ม Find 
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8. กดปุ่ ม Refresh Data เพือ่ดคูา่ Phase และ Status ของรายงานทีส่ัง่ Run ซึง่จะเปลีย่นแปลงไปจนกระท่ัง Phase 

มคีา่เป็น “Completed” และ Status มคีา่เป็น “Normal” จงึถอืวา่การสัง่ Run Report ในครัง้นี้ท างานเสร็จสิน้

สมบรูณ์ พรอ้มใหผู้ใ้ชดู้ผลลัพธต์อ่ไป 
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9. ระบบจะแสดงเลขที ่Request ID ทัง้หมด ใหค้น้หารายงานทีร่ันโดย ด ูRequest ID ทีต่อ้งการหรอื Name = 
รายงานทีร่ัน จากตัวอย่างคอืรายงาน  Transaction Register เมือ่สถานะเป็น Completed/Normal แลว้จงึกดปุ่ ม 

View output 
 

 
 

10. ระบบแสดงรายงานบนหนา้จอ 
 

 
 


